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 a 
Introduction

Paleontology Analysis Log (PAL) is a program designed to aid in the analysis and recording 
of fossil data. The data entered is subsequently saved to the central database. The main work-
ing window is a spreadsheet similar in appearance and function to Excel.

Document Layout

This document is broken up into five sections. “Shipboard Preparation and PAL Quick Guide” 
details how to prepare the PAL program before arriving at the first drill site. It also contains
quick guide to running PAL, with references to more in-depth explanations. “Getting Started” 
describes the login procedure and special features. “Main Windows & Their Functions” 
describes each window in depth and the functions each performs. “Entering Data”  describes 
the multiple ways to enter data and any special do’s or don’ts. Finally, “Special Features” 
describes, in-depth, how to import and export data, including troubleshooting tips.
Ocean Drilling Program
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Shipboard Preparation & PAL Quick Guide

Shipboard Preparation Procedures

The following are procedures to complete before the ship reaches the first drill site. These pro-
cedures will not only save you time, but also provide an opportunity to learn the program.

1. Bring your “Taxa”, “Zone”, “Age” and “Datum” lists to the ship with you.

2. Enter, import into, or select these lists in the PAL “Test”  database. If you have the lists 
in a program such as Excel, import them into PAL. If not, enter or select them from the 
PAL program to make the tables of information (See "Importing" p. 32).

3. Before reaching the first site, export all the tables you made in the “Test” database
another program such as Excel (See "Exporting" p. 29).

4. After reaching the drill site, import all the tables back into the PAL “Production”  
database (See "Importing from Test to Production Mode" p. 36).

5. Be sure to enter all data into the “Production”  mode of PAL.

Quick Guide to PAL

Setting-Up

1. Start the program by double clicking on the PAL icon.

2. Login to PAL by entering your User Name, Password and Host String in the “Logi
window (See "Getting Started" p. 4).

3. Select the Fossil Group that you will be studying from the “Select Fossil Group” w
dow. This becomes the title of your spreadsheet and links your information lists 
(zones, etc.) to your fossil group (See "“Select Fossil Group” Window" p. 10).

4. Select a list of datums that you think might occur during the leg (See "“Datums D
nary” Window" p. 15)

5. Select one or more lists of taxa from the “Taxa Dictionary” window. Select all the 
you might use in future spreadsheets. This list becomes your personal “User’s D
naries” (See "“Taxa Dictionary” Window" p. 18).

NOTE: Skip the previous step if you have already set up 
your “User’s Dictionaries” pre-leg or during transit.

6. Select your list of zones from the “Select Zones” window. This list will be availabl
for use at the main spreadsheet (See "“Select Zones” Window" p. 11).

7. Select your list of geologic ages from the “Select Geologic Ages” window. This lis
will also be available for use at the main spreadsheet (See "“Select Geologic Age
Window" p. 13)
Ocean Drilling Program
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8. Select a list of taxa specific for the current spreadsheet you are working on. Select 
these taxa from one or more of your personal User’s Dictionaries at the “Select Ta
window (See "“Select Taxon” Window" p. 21).

9. Select the samples you want to analyze at the “Select Samples” window. These 
samples that have already been entered into the Janus database. Once selected
samples are exported to the spreadsheet (See "“Select Samples” Window" p. 23

10. Enter data in your spreadsheet. Data can be typed in, or use the List button to display a 
list of choices for each cell. Unsaved data is always underlined in red. Be sure to 
save the data before opening a new spreadsheet or exiting the program (See 
"Entering Data" p. 24).

Reports
All data saved to the Janus database is accessible from reports in the Pre-defined Quer
which are available through JanusWeb. You can access a report at any time by using th
Reports option on the spreadsheet menu (See "Menu Options" p. 6).

Import/Export
Data from Excel spreadsheets can be imported into the PAL program. Spreadsheets can also
be exported from PAL to Excel. Use the Import and Export functions available from the 
Paleo menu (See "Special Features" p. 29).

Note: Several problems can occur during import and 
export, so be sure to read the, “Special Features” section, 
which describes all aspects of importing and exporting.
Ocean Drilling Program
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Getting Started

Opening PAL

To start the program, double click on the PAL icon. This opens the “Login” window.

Figure 1.Login window for PAL

Login information

Enter your User Name, Password and Host String at this window. PAL automatically 
remembers the last setup used on the current station. You can also set it to remember you
password by checking the “Remember Password” box.

After logging on, the program automatically defaults to the previous user’s spreadsheet
fossil group at that station. If you were not the previous user, select your fossil group of c
(See "“Select Fossil Group” Window" p. 10).

Later, you will also select a list of zones, ages, taxa and datum for use during analysis. 
you select these lists, they are automatically linked to your fossil group. Whenever you 
login and select your fossil group, your default lists will automatically be available to you

If more that one paleontologist is working on the same single fossil group, it is recom-
mended that all scientists entering data for that fossil group use one common User Name and 
Password. This method allows all analyzed samples to be displayed together in PAL. If each 
user has their own ID, PAL displays only those samples the individual user analyzed. See 
MCS to set up a common User Name/Password.
Ocean Drilling Program
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Main Windows & Their Functions

Once you login, the main PAL window opens. Like Excel, it is a spreadsheet into which all 
data is entered. It has several features, which are described below (See Figure 2).

\Spreadsheet Description

Figure 2 shows the default spreadsheet that opens after you login. Notice the title here 
Planktonic Foramifers”. The title of your spreadsheet will be the fossil group that you 
select.

Figure 2.Main window and spreadsheet in the PAL program.

1. The left side of the window is labeled Sample. Sample information is selected on the
“Select Samples” window and exported here (See "“Select Samples” Window" p.
Ocean Drilling Program
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2. The right side of the window displays all descriptors:

• Zone, age, preparation, preservation, group abundance, and bathymetry are 
default columns.

• Taxa are selected on the “Select Taxon” window and exported here. They will ap
as columns on this spreadsheet (See "“Select Taxon” Window" p. 21).

3. A menu bar is displayed at the top of the window for selecting PAL options.

4. A toolbar with buttons of the most used functions is displayed under the menu ba

5. An entry prompt appears under the toolbar. When typing data into a cell, the info
tion is also displayed here. Besides typing, you can also use the List button to dis-
play a list of choices for the highlighted cell. 

6. Enter any comments on the far right side of the screen.

Menu Options

Figure 3.The menu options on the PAL spreadsheet.
 

Click on a menu option to display its list of selections. Select an option by clicking on it w
the mouse.

Under Paleo

• New Spreadsheet – opens a blank spreadsheet. Be sure to save before selecting N
any unsaved data (data underlined in red) from the current spreadsheet will be de

• Save data – saves data to the central database.

• Export – exports data to another program such as Excel (See "Exporting" p. 29).

• Import – imports data back into PAL from another program (See "Importing" p. 32).

• Exit – completely exits from the PAL program.

Under Lists 

• Fossil Group – opens the “Select Fossil Group” window. Same as the Fossil Grp but-
ton or the F9 key (See "“Select Fossil Group” Window" p. 10).

• Taxa Dictionary - opens the “Taxa Dictionary” window. Same as the Taxa button or 
the F5 key (See "“Taxa Dictionary” Window" p. 18).

• Datums - opens the “Datums Dictionary” window. Same as the Datums button or the 
F6 key (See "“Datums Dictionary” Window" p. 15).
Ocean Drilling Program
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• Zones – opens the “Select Zones” window. Same as the Zones button or the F7 key 
(See "“Select Zones” Window" p. 11).

• Geologic Ages - opens the “Select Geologic Ages” window. Same as the Geo Ages 
button or the F8 key (See "“Select Geologic Ages” Window" p. 13).

• Taxa Select – opens the “Select Taxon” window. Same as the Taxa Select button or 
the F10 key (See "“Select Taxon” Window" p. 21).

• Samples – opens the “Select Samples” window. Same as the Samples button or the 
F11 key (See "“Select Samples” Window" p. 23).

Under Reports 
• Range Chart

• Investigations

• Age Model

• Age Profile

• Dictionary

• Species

Note: Click on a report to open Netscape and the report in 
JanusWeb. Once you open one report, it should be much 
faster to open a second, as Netscape is already running.

Under View

• Sort by Alpha – sorts all taxa columns in the spreadsheet by alphabetical order.

• Sort by FO – sorts all taxa columns by first occurrence.

• Sort by LO – sorts all taxa columns by last occurrence.

• Abbreviated View - basic view; shows general data for each taxa.

• P/A Det. Sam. Col. - shows only the presence or absence of each taxa in the samples.

• R/C Det. Sam. Col. - shows only whether each taxa has been reworked or contani-
mated for the samples.

• Rel. Abundance Col. - shows only the relative abundance of each taxa in the samples.

• Percent Col. - shows only the percent of each taxa in the samples.

• Count Col. - shows only the count of each taxa in the samples.

Note: Whichever view is selected when you exit the program 
remains selected when it is re-opened.

Information about reports can be 
accessed from “Predefined Queries” 
on Janus Web.
http://www-odp.tamu.edu
Ocean Drilling Program



PAL User’s Manual 8

he 
. 
 have 
Under Options

• Setup reports – opens the “Setup Reports” window (See Figure 4). This is where t
web browser and report URLs are entered for accessing the reports in JanusWeb
These should already be set, so you should never need to use this window. If you
problems, contact your MCS.

Figure 4.The “Setup Reports” window.

• Change Header Font – changes the font size on the spreadsheet.

Under Help 
• Index – this selection not developed yet.

• About Paleo – displays copyright information about the PAL program.

Toolbar Features

Figure 5.Toolbar buttons on the “PAL” spreadsheet.

• New or F3– opens a new spreadsheet. Clicking on New displays the message shown 
below only if you have any unsaved changes on the current spreadsheet. Click on Yes 
to save the unsaved data (data underlined in red). Click on No to delete the unsaved 
data.
Ocean Drilling Program
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• Save or F4– saves all data to the central database.

• Taxa or F5 – opens the “Taxa Dictionary” window (See "“Taxa Dictionary” Window
p. 18)

• Datums or F6 - open the “Datums Dictionary” window (See "“Datums Dictionary” 
Window" p. 15).

• Zones or F7 – opens the “Select Zones” window (See "“Select Zones” Window" p
11).

• Geo Ages or F8 - opens the “Select Geologic Ages” window (See "“Select Geolog
Ages” Window" p. 13).

• Fossil Group or F9 – opens the “Select Fossil Group” window (See "“Select Foss
Group” Window" p. 10).

• Taxa Select or F10 – opens the “Select Taxon” window (See "“Select Taxon” Win-
dow" p. 21).

• Samples or F11 – opens the “Select Samples” window (See "“Select Samples” Wi
dow" p. 23).

• SamDetail or F12 - opens the “Sample Taxa” window (See "Viewing Samples in 
Detail" p. 27).

• Exit – closes the PAL program. Clicking the Exit  button displays the message shown 
below. Click Yes to save any unsaved data (data underlined in red) on the spreadsheet. 
Click No to delete any unsaved data.
Ocean Drilling Program
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“Select Fossil Group” Window

First you must select a Fossil Group. Open this window by clicking on the Fossil Grp button 
or the F9 key, or by selecting it from the Lists menu.

Figure 6.The “Select Fossil Group” window.

This window lists the database Fossil Groups. Select a group by double clicking on it, or by 
highlighting it first, then pressing either the <Enter> key or the OK button.

After selecting the fossil group, you will next select zones, ages, taxa, datums and samples 
(future windows). These selections are attached to your fossil group and your login ID. The 
next time you log in and select a fossil group, these selections will automatically appear on 
your spreadsheet, and will be available at their respective windows.

If you click on the Fossil Grp button before saving any data on the current spreadsheet, the 
following message will appear. Be sure to save before selecting a new fossil group or else all 
unsaved data (data underlined in red) will be lost.
Ocean Drilling Program
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“Select Zones” Window 

After your Fossil Group, you must next select Zones. Open this window by pressing the 
Zones button or the F7 key, or by selecting it from the Lists menu.

Figure 7. The “Select Zones” window.

• All possible Zones and Zonations (author, year) for your fossil group are listed under 
the Database Zones heading.

• Select a zonation by clicking on your choice. Use the up and down arrow keys to scroll 
through the list. Selecting a zonation causes a list of zones to be displayed in the Zones 
box.

• By default, the zone list is sorted by Name. You can also sort the zones by Abbrev., 
Author/Yr., Yng (youngest to oldest), or Old (oldest to youngest) by clicking on the 
top of the column. For example, if you want to sort by Old, click on the word “Old

• Select the zones that you want to be available as choices at the spreadsheet by either 
double clicking on them, or by highlighting one first and then clicking Add. Use the 
Ocean Drilling Program
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up and down arrow keys to scroll though the list of zones.

Note: highlight multiple zones by holding down the shift key 
while clicking on individual zones.

• Select all zones displayed by clicking Add All.

• The zones you select appear on the right side in the User’s Zones/Selected Zones box. 
You can also sort the selected zones by Name, Abbrev, Author/Yr, Yng, or Old.

• Remove a zone at any time by highlighting it and clicking Remove for one, or 
Remove All to de-select all zones.

• Once you’ve selected the zones you want, click OK and they are exported to the 
spreadsheet. There they are saved as a list, which is displayed by clicking on theList 
button while a zone cell is highlighted (See "Entering Data" p. 24).
Ocean Drilling Program
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“Select Geologic Ages” Window

After selecting zones, next select the geologic ages. Open this window by clicking on the Geo 
Ages button or the F8 key, or by selecting it from the Lists menu.

Figure 8. The “Select Geologic Ages” window.

• First, select the Author, Year from the Database Ages box. Select one by clicking on 
it once. This displays a corresponding list of Geologic Ages in the lower left box.

• By default, the geologic ages are sorted by age, from youngest to oldest (see the 
“Young” column in Figure 7). You can choose to sort the geologic ages by Young 
(youngest to oldest), Old (oldest to youngest), Name, or Author, Yr. Do this by click-
ing at the top of the Geologic Ages column that you want to sort by (e.g. if you want t
sort by name, click on the word “Name” at the top of that column).

• Select a geologic age by either double clicking on it, or by highlighting it and clicking 
Add to select one. Click on the Add All button to select all ages listed. The selected 
ages are displayed in the Geologic Ages box under the Leg Ages heading.

• Select the current leg number from the Leg box. This assigns the selected geologic 
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ages to that leg. Use the up and down arrow keys to scroll through the list.

• Remove an age at any time by highlighting it and clicking Remove for one, or 
Remove All to de-select all ages.

• Clicking OK exports all ages to the spreadsheet as a list. You can view this list by 
highlighting a cell under the Age columns and clicking the List button (See "Entering 
Data" p. 24).

Adding, Editing or Deleting Geologic Ages

1. Add a new geologic age by clicking on the New button. This opens the “Geologic Age
Entry” box (See Figure 8). Enter all pertinent information and click OK. This adds the 
new geologic age to the database and can now be selected from the “Select Geo
Ages” window.

Figure 9. Enter new geologic age information here.

2. Edit an existing geologic age by clicking on an age, then the Edit button. If you did 
not enter the geologic age that you wish to edit, a warning is displayed (see belo
Click OK to continue or Cancel to stop. Clicking OK opens the geologic age’s entry
box (See Figure 8). Edit the age and click OK.

3. Delete an existing geologic age by clicking on an age, then the Delete button. If you 
did not enter the geologic age that you wish to delete, the same warning as abov
displayed. Click OK to continue or Cancel to stop. Clicking OK immediately deletes 
the age.
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“Datums Dictionary” Window

Before reaching a drill site, select a list of datums that might occur during the leg. Open this 
window by clicking on the Datums button or F6 key, or by selecting it from the Lists menu.

Figure 10. The “Datums Dictionary” window.

1. First, select a Subdivision by clicking on it once. Use the up and down arrow keys to 
scroll through the list. Selecting a subdivision causes a list of corresponding genus/
subgenus and species/subspecies to be displayed in their respective boxes.

2. Next, select either a genus or a species to display a list of all related datums in the 
Datums box. Use this list of possible datums to select those that you will use during 
the leg.

3. By default, the datums list is sorted by Datum. You can also select to sort them by 
Type, Age, or Author/Yr by clicking on the top of the column. For example, if you 
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wanted to sort by age, you would click on the word “Age.”

4. Select a datum by either double clicking on it, or by highlighting it and then clicki
the Add button. Click on the Add All button to select all the datums listed. All datum
that you select are listed in the Selected Datums box.

5. Remove a datum from the Selected Datums box at any time by highlighting it and 
clicking the Remove button for one, or the Remove All button to de-select all datums

6. Assign the selected datums to the current leg by selecting a leg number from theLeg 
box. Use the up and down arrow keys to scroll through the list.

Adding, Editing or Deleting Datums

1. Add a new datum by clicking on the New button. This opens the “Datum Entry” win
dow (See Figure 9). Fill in and select all pertinent information (using the arrows t
scroll up and down, or to display drop down lists) and click OK. The new datum is 
added to the database datum dictionary.

Figure 11. Enter new datum information here.

2. Edit an existing datum by clicking on the datum, then the Edit button. If you did not 
Ocean Drilling Program
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enter the datum that you wish to edit, you will receive the warning below. Click OK to 
continue or Cancel to stop. Clicking OK opens the datum’s entry window (See Figur
10). Edit the datum then click OK.

3. Delete an existing datum by clicking on a datum, then the Delete button. If you did 
not enter the datum that you wish to delete, you will receive the above warning. P
OK to continue or Cancel to stop. Clicking OK immediately deletes the datum.
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Next, select one or more “User’s Dictionaries” of taxa. At this window, select one or mor
lists of all possible taxa that you might use in a spreadsheet. These become your perso
tionaries. Later, you will use your personal dictionaries to select taxa for individual 
spreadsheets. Open this window by clicking the Taxa button or F5 key, or by selecting it 
from the Lists menu.

Figure 12. The “Taxa Dictionary” window.

Selecting a Dictionary Name
Before selecting taxa, you must indicate the name of the User’s Dictionary. If you are editing 
a dictionary that already exists, click on its name in the Dictionary  box. All taxa that are 
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already saved to that dictionary are displayed under the Taxa box on the User’s Dictionary 
half.

If you want to start a new dictionary click on <New> in the Dictionary  box. A blank list is 
displayed under Taxa on the User’s Dictionary half. Follow the remaining instructions for 
selecting a User’s Dictionary. 

Under Database Dictionary:
The database dictionary contains all possible taxa choices. Because of the large number, it is 
helpful to select a list, or lists, of taxa that you foresee using in the future.

1. Select a Subdivision. This causes a list of corresponding Genus/Subgenus and Spe-
cies/Subspecies to be displayed.

2. Select a Genus/subgenus. Notice that the corresponding species/subspecies is also 
highlighted (you may have to arrow down the list to see it).

3. Under Taxa all corresponding genus/subgenus and species/subspecies are listed. 

4. From this list, add those taxa that you want in your User’s Dictionary. Add one by
either double clicking on it, or by highlighting the taxon and then clicking the Add 
button. Add all taxa by clicking the Add All button.

5. Once your User’s Dictionary is complete, click OK. If this is a new list, a naming box
is displayed (See below). Fill in the name of the dictionary and click OK.

6. Repeat this procedure until you have as many User’s Dictionaries as you need. 

Note: You can add new dictionaries or edit existing ones at 
any time.

Adding, Editing or Deleting Taxa 
You can add, edit or delete taxon from the central database at any time. 

1. To add a new taxon, click on the New button. This opens the “Taxon Entry” window
(See Figure 12). Fill in the blanks with the appropriate information and click OK. This 
adds the new taxon to the central database and makes it available on the “Taxa 
nary” window.
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Figure 13.The “Taxon Entry” window.

2. To edit an existing taxon, click on the taxon then the Edit button. If you did not enter 
the taxon that you wish to edit, a warning is displayed (See below). Click OK to con-
tinue or Cancel to stop. Clicking OK opens the taxon’s entry window (See Figure 12
Edit the taxon and click OK.

3. To delete an existing taxon, click on the taxon, then the Delete button. If you did not 
enter the taxon that you wish to edit, the above warning is displayed. Click OK to con-
tinue or Cancel to stop. Clicking OK immediately deletes the taxon.
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“Select Taxon” Window

Next, select taxa for each spreadsheet that you make from the “User’s Dictionaries” you
ated. Do this at the “Select Taxon” window (See Figure 13). Open this window by clicking
Taxa Select button or F10 key, or by selecting it from the Lists menu.

Figure 14. The “Select Taxon” window.

1. Select the user’s dictionary that you want to select taxa from. Do this by clicking 
one of the names in the Dictionary box. Use the up and down arrow keys to view al
selections. A list of corresponding taxa is then displayed in the Taxa box.

Note: you must already have set up your personal user’s dic-
tionaries in order to complete this process (See "“Taxa Dic-
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2. Select all the taxa you want for the current spreadsheet. Either double click on each 
choice, or highlight a taxon and click Add. To select all the taxa listed, click on the 
Add All  button.

3. Your choices are now displayed in the Spreadsheet Taxa box. Remove a taxa by high-
lighting and clicking Remove for one, or Remove All for all choices.

4. Click OK  and each taxa on your Spreadsheet Taxa list is exported to become a col-
umn on your spreadsheet. 

Removing Taxa from a Spreadsheet
You can  remove taxa at any time from your spreadsheet.

1. From the spreadsheet, click on the Taxa Select button. This opens the “Select Taxon
window.

2. From the “Spreadsheet Taxa” side of the window highlight the taxa you want to 
remove, then click on the Remove button.

3. Click OK. The following message will be displayed. If you want to save the data a
ciated with the that taxa you are removing from the spreadsheet, click Yes. If not, click 
No. 

Editing Your User’s Dictionary
To edit your personal User’s Dictionary, click the Edit Taxa Dict button on the “Select 
Taxon” window. This opens the “Taxa Dictionary” window (See "“Taxa Dictionary” Window
p. 18).
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“Select Samples” Window

This is the final stage before data entry. Select specific samples from the Janus database to be 
analyzed. Open this window by clicking the Samples button or F11 key, or by selecting it 
from the Lists menu.

Figure 15. The “Select Samples” window.

1. Select the leg, site, hole, core, section, and sample code from the top left lists. Notice 
that hole, core, and section default to “all” when no choice is made. Once you’ve 
selected this information, the program will default to these settings until changed

2. The bottom left box displays the Samples that correspond to the leg/site/hole inform
tion you selected. 

3. Select samples for the spreadsheet by either double clicking on them, or by high
ing one and clicking Add. To select all samples shown, click the Add All button.

4. The samples you chose are now in the Selected Samples box. Remove a sample by 
highlighting and clicking Remove for one, or Remove All for all samples shown.

5. Add a sample that is not in the Samples list by entering the top and bottom depth an
volume, and then clicking the Add New button.

6. Click OK and these samples are exported to the spreadsheet.
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Entering Data

After selecting your fossil group, zones, taxa, and samples, you should have a spreadsheet 
similar to Figure 15. Notice that the selected samples are now on the left side of the spread-
sheet and the taxa are columns.

Figure 16.The PAL spreadsheet after all selections are made.

For each sample:

1. Enter the Zone range. Highlight a cell under zone, then click the List button or the 
right mouse button to display the range of zones you selected earlier (See Figure 16). 
Click on a zone and it is entered into the highlighted cell. Do the same for Age (the 
process is the same, but a list of ages instead of zones is available by clicking on the 
List button or the right mouse button).
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Figure 17.The list of choices for “Zone”

2. Preparation, Preservation, Group abundance, and Bathymetry have List choices 
that are part of the program. Highlight a cell under any of these columns, click the List 
or the right mouse button, and choose one of the selections.

3. Finally, enter data for each of your taxa. Click in the cell of choice and either:

• Type in the value: if you are indicating a percent, the number must be followed by a 
period or the percent sign. If you are indicating a count, just enter the integer.

OR

• Click on the List button and select one of the pre-programmed values (see below).

• If you only want to indicate the presence or absence of a taxa, enter P or * for present, 
or A or - for absent.

• If you want to indicate that a sample was reworked or contaminated, enter an R for 
reworked, or a C for contaminated (you can enter these symbols alone or along with 
integers or percents).

4. Your final spreadsheet should look similar to Figure 17.
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Figure 18.PAL Spreadsheet with newly entered data.

• Notice all the data underlined in red. This is data that has NOT been saved to the 
central database yet. Saving the data erases the underlining.

• If you hit Exit or New before saving you will lose everything on the spreadsheet 
underlined in red. Be sure to Save before exiting or refreshing the screen.

• In Figure 17, the taxa are arranged by first occurrence. You can select alphabetical, 
first occurrence, or last occurrence order from the View menu.

Note: The next time you open the PAL program and select 
your fossil group, the same spreadsheet will appear, minus 
the samples and data. If you select the same samples again, 
the data is displayed in the spreadsheet as it was saved to the 
central database. 
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Viewing Samples in Detail
You can view the entries for a specific sample in detail. Do this by highlighting any cell in the 
sample row you want to view, then click the SamDetail button or the F12 key. This opens the 
“Sample Taxa” window (see Figure 18).

Figure 19. View samples in detail here.

• All taxa for the selected sample are listed on the left hand side in the gray boxes.

• The columns indicate the Presence or Absence of a taxon (P/A), whether it has been 
Reworked or Contaminated (R/C), its abundance (Abund), percent (%), or count, or 
any comments entered.

• The first three columns, P/A, R/C, and Abund, have lists of possible entries built into 
the PAL system. To open these lists, right click in the cell that you want to eneter a 
value for. A list of possible entries will pop up on the screen (See Figure 19). Select 
your choice from the list by left clicking on it with the mouse. That value is now 
entered into the cell and the next cell in the row is highlighted.
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Figure 20. Possible selections for the “Abund” column.

• Enter a count into the “Count” column by using the + and - buttons on the screen or on
your keyboard. The lowest count possible is zero.

• You can edit any of the entries already on the screen, or add new ones.

• Click OK to save any of the changes you made (this also re-opens the spreadsheet). 
Click Cancel to close this window and re-open the spreadsheet.

• If you want to edit the list of taxa, click the Taxa Dict button to open the “Taxa Dictio-
nary” window, or the Taxa Select button to open the “Select Taxon” window.

Viewing Sample Details from the Main Spreadsheet
From the main spreadsheet you can view sample details such as “Abundance” and “Cou
selecting one of these details from the View menu. While your spreadsheet is in one of thes
views, the original data from the spreadsheet (Abbreviated View) won’t be visible, but ha
been deleted. Just select Abbrev. View from the View menu to return to the normal spread-
sheet.

If you are in any view other than Abbreviated, the name of the view will be displayed in re
the main spreadsheet above the samples.
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Special Features

Exporting

After entering your data into the PAL database, you can export it to Excel for your own 
spreadsheet. This is done from the main PAL window. Export files with or without samples.

1. From the Paleo menu, select Export. This opens the “Export to…” window (See Fig
ure 20).

2. Enter a file name. You will want to save the file as a Comma Delimited File, so after 
the file name type “.csv” (e.g. in Figure 20 the filename is “mydata.csv”).

3. Select a folder to save the data in (e.g. in Figure 20 the folder is C:\ODP\Paleo) 
click OK.

Figure 21.Enter file name of data to be exported here.

4. Open Excel, then open the “PAL” spreadsheet:

• From the File menu select Open.

• Under Files of Type: select “Microsoft Excel File”. 

• From the Look in: box select the folder where PAL is installed. This is usually 
C:\ODP\Paleo

• Select the Excel “PAL” file from this folder (See Figure 21).

• Click Open. 
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Figure 22.Open the Excel “PAL” file from here.

5. A window about Macros will open. Click Enable Macros. The macro function will 
put your data in a layout identical to the PAL spreadsheet after steps 6, 7, and 8 below.

6. Next, open your data

• From the File menu select Open. 

• From Files of Type: select “Text Files” (see below).

• From Look in: select the folder you saved the data to (e.g. in Figure 22 the folder is in 
C:\ODP\Paleo).

• Highlight the correct file and click Open.
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Figure 23.Open your Excel spreadsheet from this window.

7. From the Tools menu choose Macro, then Macros (See below).

8. You should now be at the “Macro” window. Click Run. 

9. Your data is now in a format comparable to the PAL program. Save this.

Exporting From Pre-Defined Queries
If you are exporting data from one of the predefined queries in JanusWeb, you will need to 
send the data as a Comma Delimited File. On the query page, there is a drop down list box
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for selecting “Output type” (See Below). Highlight the “Comma Delimited File” selection 
before proceeding.

If you only want to see your data in a table format only, but not export it, select the HTML 
Table choice.

Importing

If you make changes to your data while in Excel, the changes should also be made in th
tral database. Do this by importing your altered data back into the PAL program. You can 
import files with or without samples to the program.

1. Save your data in Excel as a “.csv”  file (Comma Delimited File).

2. Close your file and Excel (PAL won’t work while the file is open in Excel).

3. Open PAL. It will open to the spreadsheet window.

4. From the Paleo menu select Import. Selecting Import displays the message shown
below. Be sure to save the data of the current spreadsheet before importing a sp
sheet or any unsaved data will be lost.

5. This opens the “Export to…” window (See Figure 23). Highlight the file you want
import and click OK.
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Figure 24.Import back to PAL program from this window.

Import Errors
The PAL program checks for discrepancies between the taxa names you import and those 
already in the central database. If it detects none, the spreadsheet displays all added or 
changed data with a red underline. Save this to the central database.

If PAL does detect a discrepancy, the “Find Taxon” window will open and one of the follo
ing possible scenarios will then occur: 

• If you misspelled the taxon, but at least the first letter is correct, the program finds 
the closest match(es) and displays it (see figure 24). Click on the correct one and press 
OK.

Figure 25.The “Find Taxon” window.
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• If the program does not recognize the taxon, it still displays the closest match that 
beings with the same letter. If the matches are incorrect, click Find Again. If this still 
does not work, the next scenario will occur:

• If the program can find no match at all, it displays a window with the taxon and a 
warning (See figure 25). At this point you must either correct the taxon in Excel, or 
add it to the database at the “Taxa Dictionary” window (See "“Taxa Dictionary” W
dow" p. 18). 

Figure 26. Warning displayed when no match is found.

1. First, click Cancel, to cancel the import. The program defaults to the spreadsheet,
from here you can make the appropriate changes.

2. Once you make the appropriate changes, import the file again and all changes s
now appear on the PAL spreadsheet.

Import Troubleshooting

Several errors can occur when importing spreadsheets into the PAL program. The following is 
a list of spreadsheet requirements you must meet before you can import a file into PAL.

1. You must include all columns in the exact order as the PAL spreadsheet. Data doesn’
have to be entered in each column, but the column titles must be entered.

2. If you don’t close your file in Excel before importing, or if the spreadsheet is com-
pletely empty, you will receive the following warning:

 No data found in the file, or unable to open the file. If this file is open in 
another application you might want to try closing it so PAL can have 
access to the file.     OK
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3. You must have at least two lines of headers. The first line must include “Sample”
“Zones”, and “Age”. The second line must have “leg”, “site”, “H”, etc. from the PAL 
spreadsheet. If it does not contain two lines of headers, you will receive the follow
warning:

4. You must have at least 19 columns in the first line. If not you will receive the follo
ing warning.

5. The first line must contain the following words in their respective columns: “Samp
- column 1, “Zone” - column11, “Age” - column13, and your fossil group name in 
umn 19. If not you’ll receive the following warning:

6. The second row must have 19 or more columns (19 required columns plus howe
many taxa you’ve added), a title for each column, and “Comments” as the last col
If not you’ll receive the following warning:

7. If you’ve added all the correct columns and you’re still getting this message, it is 
possible that you have a column activated past the “Comments” column. Delete 
several of the columns after “Comments” and try to import again.
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Importing from Test to Production Mode

Problems can occur when importing a spreadsheet that was made in “test” mode into th
duction” mode.

Two possible scenarios you might encounter:

You export a spreadsheet with taxa to Excel from the “test” mode.

• While in Excel you add a new taxon name that isn’t in the PAL dictionary.

• When you import into PAL, the program doesn’t recognize the new name.

• The program searches for a match, but can’t find one and gives you a warning te
you this.

• At this point you must terminate the import and add the new taxon into the database 
dictionary. See "“Taxa Dictionary” Window" p. 18 for directions on adding taxa.

You add a new taxon into the dictionary in “test” mode.

• You export the spreadsheet with the new taxon to Excel.

• You add the new taxon into the PAL dictionary while in “production” mode.

• You import the spreadsheet into the “production” mode of PAL.

• The program claims to not recognize the taxon you entered, then gives the closest 
match which is actually the same taxon.

• The reason the program does this is because an ID is attached to each added taxon. The 
ID attached under “test” mode is different than that in “production” mode. Thus, w
it imported the new taxon, the program did not recognize the ID. Instead it shows
closest word match, which turns out to be the same taxon.
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